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1. 快速入门 

英飞凌推出基于 ARM Cotex-M0/4 的 XMC 系列 MCU 已经有近 4 年的时间了，在这期间，我

们组织过很多 XMC MCU 培训和研讨会，也解决了很多客户实际项目中遇到的问题。但是在

培训中，我们使用的大多是 PPT 格式的材料，这些材料一般只是列出结构框图和功能概要，

而在解决客户问题的过程中，我们大多以邮件的方式讨论和解决问题。此书的编写目的就是把

以前的材料都整编在一起，给在使用 XMC MCU 的用户提供开发线索，从而让 XMC MCU 的

开发和使用变得简单明了。 

 

XMC MCU 官方网站： 

首先，英飞凌有一个很完善的官方网站，上面几乎能找到所有 XMC MCU 的开发资料，包括

数据手册，工具，示例代码等。下面是英飞凌 XMC MCU 官网地址： 

http://www.infineon.com/xmc 

 

XMC MCU 相关手册： 

XMC MCU 的手册大致有 3 类：数据手册（Data Sheet），参考手册（Reference Manual）

和勘误手册（Errata Sheet）. 

数据手册主要包含 MCU 特性介绍，订购信息，封装类型，引脚定义，电气参数，外形尺寸

等。 

参考手册主要包括 CPU 子系统介绍（总线系统，指令集，通用寄存器），存储器结构和地址

映射，时钟系统，外设介绍等。其中外设部分可分为 4 个部分，分别是通讯部分外设，模拟部

分外设，工业控制部分外设，以及 GPIO 部分。 

勘误手册主要记载异常功能（实际功能和参考手册不符的部分），异常的电气和时序（实测数

据和数据手册中的数据不符的部分），以及实际应用中需要注意的一些点。用户在使用芯片的

过程中如果怀疑可能是芯片出问题了，可以首先查一下勘误手册中有没有列出这一条。 

除了这三类基础手册，我们还提供各个外设的应用笔记（ Application Notes）以及附带的样

例代码，帮助用户快速的掌握各个外设的基本功能。另外在 MCU 培训中使用的 PPT，也已经

放在官网上了。 

下面是 XMC1000 系列手册的下载地址： 

http://www.infineon.com/xmc1000 

 

http://www.infineon.com/xmc
http://www.infineon.com/xmc1000
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下面是 XMC4000 系列手册的下载地址： 

http://www.infineon.com/xmc4000 

 

 

 

开发环境： 

DAVE4 是英飞凌自主开发的基于 Eclipse 的免费集成开发环境，它不仅包含 GNU 编译器和调

试器，而且还集成了丰富的 APP。下面是 DAVE4 的下载地址： 

http://www.infineon.com/dave 

 

 

 

开发工具（仿真器）： 

XMC MCU 的仿真器主要有 J-Link 和 DAP miniWiddler. 英飞凌提供的开发套件一般都集成了

J-link. 另外英飞凌也有自己开发的 J-link (XMC-Link), 客户自己做的板子也可以使用标准的

Segger J-link. DAP miniWiddler 是英飞凌自己生产的 Jtag 调试器，除了调试 XMC MCU， 也

可以调试英飞凌其它私有核的 MCU。 

XMC-Link 的介绍链接如下： 

www.infineon.com/xmclink 

 

DAP MiniWiddler 的介绍链接如下： 

http://www.infineon.com/cms/en/product/microcontroller/development-tools-software-and-
kits/dap-miniwiggler/channel.html?channel=db3a30432239cccd0122e537b4dc3c53 

 

 

 

 

 

http://www.infineon.com/xmc4000
http://www.infineon.com/dave
http://www.infineon.com/xmclink
http://www.infineon.com/cms/en/product/microcontroller/development-tools-software-and-kits/dap-miniwiggler/channel.html?channel=db3a30432239cccd0122e537b4dc3c53
http://www.infineon.com/cms/en/product/microcontroller/development-tools-software-and-kits/dap-miniwiggler/channel.html?channel=db3a30432239cccd0122e537b4dc3c53
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编程 (烧写) 工具： 

英飞凌原厂提供的烧写工具有 MemTool 和 XMC Flasher.  MemTool 支持串口烧写 XMC 

MCU。XMC Flasher 支持 SWD 接口烧写 XMC MCU.  

它们的下载链接如下： 

www.infineon.com/xmc/ecosystem 

 

 

另外 XELTEK 和 WAVE 的离线烧写器支持对 XMC MCU 离线烧写。 

关于 XELTEK 的烧写器可以访问下列网址： 

http://www.xeltek.com.cn/en/index.html 

 

关于 WAVE 的烧写器可以访问下列网址： 

http://www.wave-cn.com/ 

 

uc/Probe: 

英飞凌最近发布了一款新的调试工具 – uc-Probe，可以实时的观察变量或者外设寄存器的变

化。它以各种控件的形式表示实际的量值，例如文本框，仪表盘，甚至示波器。这种形式的调

试会对一些需要动态观测参数的应用带来很大的方便，例如电机和数字电源应用。但是使用它

之前，需要首先 download 程序到 MCU，然后 load elf 文件到 uc-Probe。 

uc-Probe 这个工具是 Micrium 开发的。一般来说，开发者如果需要使用，需向 Micrium 购买

License. 我们提供的版本是 Micrium 给 Infineon 定制的，即只能调试 XMC MCU，并且是免费

提供给 XMC 用户使用的。它的下载链接如下： 

http://www.infineon.com/dave 

 

 

http://www.infineon.com/xmc/ecosystem
http://www.xeltek.com.cn/en/index.html
http://www.wave-cn.com/
http://www.infineon.com/dave
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引脚分配工具： 

XMC MCU 的管脚都是很多外设一起复用的，所以在分配引脚的时候给用户带来了一些困扰。

因此我们开发了一个引脚分配工具（XMC Pinout Tool）, 可以根据所选择的外设来选择各个

外设的功能引脚。这个工具在芯片选型和硬件设计的时候都是非常有用的。下面是这个工具的

下载地址： 

www.infineon.com/xmc/ecosystem 

 

 

http://www.infineon.com/xmc/ecosystem
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XMC MCU 开发套件： 

英飞凌提供很多 MCU 开发套件，可以在下列网站了解详细信息和在线购买： 

www.infineon.com/xmc-dev 

 

对于每个开发套件，都能在各自链接找到评估板使用说明书（含原理图），附带例程以及

PCB 封装库等。 

以 XMC1300 的开发套件为例： 

 

 

 

 

http://www.infineon.com/xmc-dev
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底层驱动库（Low Level Driver, LLD）: 

英飞凌提供完整的底层驱动库，支持所有 XMC MCU, 包含所有外设驱动。底层驱动库可以在

下面链接下载。 

www.infineon.com/xmclib 

 

DAVE4 中已经把底层驱动库整合进去，所有 DAVE4 中的例程和 APP 都是基于底层驱动库编

写的。 

IAR Embedded Workbench v7.x 和 Keil MDK v5.x 也已经把底层驱动库整合进去，后续章节

会介绍如何在 IAR 和 Keil 环境下使用底层驱动库。 

 

RTOS: 

XMC MCU 已经支持很多 RTOS, 包括 FreeRTOS, uC-OS, RTX 等。关于 XMC MCU 在这些

RTOS 移植的示例程序可以在下面链接下载： 

www.infineon.com/xmc/ecosystem 

 

官方论坛： 

英飞凌有一个技术社区，里面有关于 XMC MCU 的技术论坛，里面有很多技术问题的讨论，

用户碰到问题可以放到那个论坛上，也有可能从那个论坛上找到问题的答案。另外社区中也有

很多技术可以下载。下面这个是技术社区的连接： 

http://www.infineonic.org/ 

 

除了中文的技术社区，英飞凌还有官方的英文论坛，在这个论坛，有新加坡和德国 XMC MCU

技术专家维护和支持，用户也可以在这个论坛上寻求支持。英文官方论坛地址如下： 

http://www.infineonforums.com/ 

 

http://www.infineon.com/xmclib
http://www.infineon.com/xmc/ecosystem
http://www.infineonic.org/
http://www.infineonforums.com/


     

第 11 页  

 

2. 项目开发流程 

2.1 流程概述 

 

对于 XMC MCU 的新手来说，很多人都觉得使用英飞凌的 XMC MCU 去开发一个项目会无从

下手。在这里，我们站在用户的立场上去思考怎么样让一个从来没使用过 XMC MCU 的新手

能慢慢的熟悉 XMC MCU，并快速的将 XMC MCU 应用到实际项目中去。 

一般基于 MCU 的项目的开发流程如下： 

 

需求分析

芯片选型

选择所需评估套件

安装和熟悉开发环境

学习所需的外设

硬件设计

软件设计

调试

芯片烧写

量产

 

 

下面表中列出在开发流程中，英飞凌可以提供的一些帮助，从而加快项目的研发。 

开发流程 英飞凌能提供什么 备注 

需求分析 

在英飞凌的官方网站可以下载到芯片数

据手册和用户手册，帮助分析各个产品

是否满足需求。 

如需查看封装和外设资源，则可以查看数据手

册。 

芯片选型 

在英飞凌的官方网站上就可以对芯片进

行选型： 

http://www.infineon.com/xmc1000 
http://www.infineon.com/xmc4000 
 

- 

http://www.infineon.com/xmc1000
http://www.infineon.com/xmc4000
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选择评估

套件 

在下列网站可以选择和购买需要的评估

套件，可以下载相关文档和示例程序： 

www.infineon.com/xmc-dev 
 

英飞凌提供基本的入门套件（Boot Kit），演示

套件(Demo Kit)和应用套件(Applicaiton Kit) 

熟悉和安

装开发环

境 

DAVE下载地址（免费）： 

http://www.infineon.com/dave 

Keil下载地址： 

http://www.keil.com 

IAR下载地址： 

http://www.keil.com 

DAVE是基于Eclipse的免费开发环境，它内部集

成了APP，可基于GUI配置直接生成代码。但是

它的编译和执行效率较低。 

Keil MDK和IAR Embedded Workbench是专用的

集成开发环境，在市场广泛使用，编译和执行效

率都较高，但是需要购买Lisence才能使用。 

学习所示

外设 

英飞凌提供3种形式的例程。 

- 基于LLD的例程 

- 直接寄存器访问的例程 

- 基于APP的例程 

基于LLD的例程可以在英飞凌的官网上下载到。

直接寄存器访问的例程可以在英飞凌的社区论坛

上找到，APP 例程则集成在DAVE中。 

硬件设计 

因为XMC MCU的GPIO是复用的，一个

GPIO通常有多种功能，因此英飞凌提供

了引脚分配工具，在硬件设计的时候，

可以帮助工程师进行引脚分配。 

www.infineon.com/xmc/ecosystem 

其实英飞凌还发布一个文档： 

APP_XMC4000_PCB_Design_Guidelines_v1_0 

描述在用XMC4000时候，硬件设计上的一些注

意事项。 

修改BMI 

在 进 行 软 件 设 计 之 前 ， 如 果 使 用

XMC1000, 则需要注意BMI的模式。新的

XMC1000芯片出厂时的BMI是ASC_BSL

模式，这个模式是用来串口烧写的。如

果需要调试，则需要把BMI模式改成

USER_MODE(SWD)。 

目前提供了三种方法修改BMI： 

在DAVE中可以修改BMI, 请查看4.4.6节 

使用J-Link命令行可以修改BMI，请查看5.4.2 

使用XMC Flasher可以修改BMI，请查看6.2.3 

软件设计

和调试 

英飞凌最近发布了一款软件-uc/Probe,可

以把变量和GUI控件联系起来，用控件的

方式观察变量的实时变化。下载地址如

下： 

http://www.infineon.com/dave 
 

uc-Probe这个工具是Micrium开发的，一般来

说，开发者需要使用需向Micrium购买License. 

我们提供的版本是Micrium给Infineon定制的，即

只能调试XMC MCU，并且是免费提供给大家用

的。 

芯片烧写 

烧写可以分为串口烧写和SWD接口烧

写。 

 

下面工具支持串口烧写： 

- MemTool 

- 伟福J-Master烧写器 

- 希尔特烧写器 

-  

下面工具支持SWD接口烧写： 

- XMC Flasher 

- 伟福J-Master烧写器 

- XELTEK烧写器 

 

在测试或者小批量生产时，可以使用MemTool和

XMC Flasher烧写少量芯片。这两个工具的下载

链接如下： 

www.infineon.com/xmc/ecosystem 

 
在批量生产时，可以使用伟福J-Master烧写器或

者XELTEK烧写器。 

 

关于XELTEK的烧写器可以访问下列网址： 

http://www.xeltek.com.cn/en/index.html 
 

关于WAVE的烧写器可以访问下列网址： 

http://www.wave-cn.com/ 

 

 

 

 

 

http://www.infineon.com/xmc-dev
http://www.infineon.com/dave
http://www.keil.com/
http://www.keil.com/
http://www.infineon.com/xmc/ecosystem
http://www.infineon.com/dave
http://www.infineon.com/xmc/ecosystem
http://www.xeltek.com.cn/en/index.html
http://www.wave-cn.com/
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2.2 项目开发实例 

下面以冰箱变频控制器为例，来介绍开发流程的各个步骤。 

 

需求分析： 

下图是冰箱变频控制器的结构框图，在这个系统中，MCU 需要用 3 对互补 PWM 去控制伺服

电机，用 ADC 去采样电流 a 相和 b 相，用模拟比较器去比较 I 相电压，另外需要一路 UART

和主板通讯。 

MCU

Rectifier

AC-DC

UART

M

HVIC

HVIC

HVIC

IG
B

T
*6

OP

OP

OP

AC

VDD ADC

C
C

8

Trip

ADC Temp.

Ia

IbADC

ADC

ACMP I

USIC

Vbus

 

 

下面是基于系统分析后，对 MCU 的详细需求： 

主频 >=32MHz 

Flash >=64KB 

RAM >=8KB 

PWM 输出 3 对互补 

ADC 通道 4 

UART 通道 1 

模拟比较器 1 
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芯片选型： 

根据上面需求，可以稍微做进一步的分析： 

 

主频 >=32MHz 可以考虑 M0 的

32MHz 产品 

Flash >=100KB 至少要 128KB 

RAM >=16KB  

PWM 输出 3 对互补 需要 1 unit CCU8 

ADC 通道 4  

UART 通道 1 需要 1 unit USIC 

模拟比较器 1 需要有 ACMP 

 

接下去可以打开下面链接进行芯片选型： 

http://www.infineon.com/xmc1000 

 

打开链接后往下拉，看到下列页面后，点击”Show all Parameter”，然后它就会把所有的参数

显示出来。 

 

 

接着可以先选择 32MHz 的主频，然后再选择 128KB 的 Flash size, 再接着选择 1 路 CCU8 和

USIC, 接着选择一个芯片的封装，就可以找到 XMC1302-T038X0128AB 这个型号的 MCU。 

 

 

http://www.infineon.com/xmc1000
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选择所需评估套件： 

对于从未使用过 XMC MCU 的新手，在开发项目之前，非常有必要选择一套评估套件进行学

习，对于 XMC1300 系列可以选择下列套件（套件链接见第一章）： 

 

 

安装和熟悉开发环境： 

我们推荐使用的开发环境有 DAVE4，Keil MDK, IAR Embedded Workbench. DAVE4 是免费

的，Keil MDK 和 IAR Embedded Workbench 则需要购买 license 或者只能使用限制版本（30

天或者 32KB 版本）。 

DAVE4 的下载链接如下： 

www.infineon.com/dave 

 

Keil 的下载，请访问 Keil 的官方网站： 

http://www.keil.com/ 

 

IAR 的下载，请访问 IAR 的官方网站： 

https://www.iar.com/ 

 

现在的开发环境一般都集成非常强大的帮助文档（用户手册）。在阅读帮助文档后，用户可以

非常快的熟悉开发环境。 

 

点击工具条中的 Help | Help Contents 能打开 DAVE 的帮助文档： 

 

 

 

 

 

 

 

http://www.infineon.com/dave
http://www.keil.com/
https://www.iar.com/
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点击 DAVE User Manual | Getting Started 

 

 

 

 

对于从未使用过 DAVE 的新手，可以先看 Your First steps with DAVE, 里面介绍了如何新建

一个工程，如何使用 DAVE APP 等，接着可以看 Composing your first application using 

DAVE APPs, 里面会介绍如何把两个 APP 结合起来使用在一个项目中，接着可以看 

Downloading and debugging your application, 里面介绍如何下载和调试代码。学习完这

三个步骤后就基本能够正常使用 DAVE4 这个环境了。 
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在 Keil MDK 中，点击 Help | uVision, 可以打开 Keil 的帮助文档： 

 

 

 

首先可以点击”Creating Projects”, 就可以查看如何在 Keil 环境下新建一个工程，对于 Keil 

MDK 5 以上的版本，Pack 是非常有用的组件，里面集成了很多有用的软件，例如底层驱动

库，CMSIS 库，中间件（RTOS，TCP/IP 等），例程等。可以查看 Pack Installer，可以了

解怎么样下载和安装 Packs.  

 

在 IAR Embedded Workbench 中，点击 Help | Getting Started with IAR Embedded 

Workbench, 可以打开 IAR 的帮助文档。查看“Createing an application project”，可以

了解怎么样新建工程。查看“Debugging”, 了解怎么样调试。 
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学习所需外设： 

XMC MCU 有非常丰富的外设资源，但是在开发时间有限的情况下，可以只学习项目中用到的

一些外设。例如上面这个冰箱变频控制板这个项目，可以只学习 ADC, CCU8, UART, GPIO, 

ACMP 这几个外设。 

我们提供几种形式的例程：基于 LLD 的例程，直接访问寄存器的例程，基于 APP 的例程，以

及开发套件自带的一些例程。 

 

对于基于 LLD 的例程，首先我们提供很多基于 DAVE4  LLD 例程，可以在下列网站下载： 

下面是 XMC1000 系列 LLD 例程的下载地址： 

http://www.infineon.com/xmc1000 

 

 

 

 

 

 

http://www.infineon.com/xmc1000
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下面是 XMC4000 系列 LLD 例程的下载地址： 

http://www.infineon.com/xmc4000 

 

 

这些例程是和应用笔记相结合的，可以先看应用笔记再跑例程代码，这个能达到最好的学习效

果。 

 

在 Keil MDK v5.x 和 IAR Embedded Workbench v7.x 中，已经集成了 LLD 和很多示例代码，

关于如何在 Keil 和 IAR 上使用 LLD, 可以打开上面链接，查看下面文档： 

 

 

对于直接访问寄存器的例程，放在英飞凌中文社区的资料下载里面： 

 

 

http://www.infineon.com/xmc4000
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例如搜索 ADC, 就能找到很多基于 Keil 或者 DAVE 的寄存器直接访问的例程。 

 

 

 

对于基于 APP 的例程，可以打开 DAVE4，然后新建一个 DAVE CE 的工程，然后就能选择

APP，把它导入到工程，接着点击 Generate Code, 编译后就能使用这个 APP 了。 

点击下面加号选择 APP： 
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对于如何使用这个 APP，则可以看说明文档，如下所示。 

                  

 

 

 

 



 

 

第 22 页 

 

硬件设计： 

在这个系统中，MCU 需要用 3 对互补 PWM去控制伺服电机，用 ADC 两个通道去采样电流 a

相和 b 相，另两个通道去采样温度和供电电压，用模拟比较器去比较 I 相电压，另外需要一路

UART 和主板通讯。 

我们可以使用引脚分配工具（XMC Pinout tool）进行引脚分配。这个工具的下载地址见第一

章。 

1) 打开工具后，先选择 MCU 型号和封装 

2) 选择所需的外设 
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3) 接着就可以选择各个外设所要使用的引脚。 

这里选择使用 CCU80 产生 3 对互补 PWM，USIC 的通道 0 作为 UART 模式，ADC 的

group0 的 4 个通道去进行采样，ADC 比较器的通道 2 去做模拟比较输入。 
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4) 接着就可以在另外一个串口看到如下引脚分配图，在画原理图的时候，可以直接根据这个

表来分配引脚。 

 

 

5) 选择 Overview 的 table, 点击 Save，也可以把引脚分配表保存成 excel 文档。 
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软件设计和调试： 

根据前面介绍，我们提供的例程有 3 种：基于 LLD 的例程，直接访问寄存器的例程和基于

APP 的例程。 

如果使用的是基于 LLD 的例程，那么在实际系统中，可以根据项目需要，把几个用到的外设

封装成 High Level Driver, 例如 uart.c, adc.c, ccu8.c，如果 UART 只是用到了查询模式，那么

uart.c 中可以只实现 UART 查询模式的读写数据。 

如果使用的是直接访问寄存器的例程，那么在实际系统中，可以根据项目需要，把几个用到的

外设封装成 Low Level Driver，例如例如 uart.c, adc.c, ccu8.c 等。 

如果使用的是基于 APP 的例程，可以根据项目需要，把几个 APP 整合在一起，如何整合可以

看 DAVE4 的帮助文档。关于调试，也可以看各个开发环境的帮助文档。 

另外，英飞凌最近发布了一款新的调试工具 – uc-Probe，可以实时的观察变量或者外设寄存

器的变化。它以各种控件的形式表示实际的量值，例如文本框，仪表盘，甚至示波器。这种形

式的调试会对一些需要动态观测参数的应用带来很大的方便，例如电机和数字电源应用。但是

使用它之前，需要首先 download 程序到 MCU，然后 load elf 文件到 uc-Probe。具体请看第

7 章。 

 

芯片烧写： 

芯片的烧写可以选择 XMC Flasher, MemTool, Xeltek 烧写器，WAVE 烧写器。 

XMC Flasher 支持用 SWD 接口烧写 XMC MCU, MemTool 支持串口烧写 XMC MCU。它们的

下载地址如下： 

www.infineon.com/xmc/ecosystem 

 

 

另外 XELTEK 和 WAVE 的离线烧写器支持对 XMC MCU 离线烧写。 

关于 XELTEK 的烧写器可以访问下列网址： 

http://www.xeltek.com.cn/en/index.html 

 

关于 WAVE 的烧写器可以访问下列网址： 

http://www.wave-cn.com/ 

http://www.infineon.com/xmc/ecosystem
http://www.xeltek.com.cn/en/index.html
http://www.wave-cn.com/
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3. 产品介绍 

3.1 产品路线 

XMC MCU 产品包括基于 ARM Cotex-M0 内核的 XMC1000 家族和基于 ARM Cotex-M4 内核

的 XMC4000 家族。 

 

 

XMC1000 家族目前有 XMC1100, XMC1200, XMC1300 和 XMC1400 四个系列的产品。

XMC1100 系列是 XMC1000 家族中入门的产品，它有 32 位机的性能，但是价格和 8 位机不

相上下，因此主要用来替换原来的 8 位机，用于一些简单的通用领域。 

XMC1200 系列比 XMC1100 增加了 BCCU 单元，可实现硬件自动调光，非常适合 LED 调光

的应用。 

XMC1300 系列则在 XMC1200 的基础上又增加了 CCU8, MATH, POSIF 单元，非常适合于电

机控制和数字电源的应用。一个 CCU8 单元可以输出 8 对互补 PWM信号。MATH 单元可以

用硬件实现三角函数，矢量运算以及除法运算。POSIF 是位置检测单元，可以检测 Hall 信号

和位置编码器信号。 

XMC1400 系列是最新推出的产品。和 XMC1300 相比，XMC1400 的主频提高到 48MHz, 并

且增加了 CAN 模块。 
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XMC4000 家族目前有 XMC4100, XMC4200, XMC4300, XMC4400, XMC4500, XMC4700 和

XMC4800 七个系列的产品。 

XMC4100 系列的 XMC4000 家族的入门级产品，主频达 80MHz，内部集成了很多用于电机控

制的外设（CCU4, CCU8, POSIF）以及高精度 PWM单元，可应用于白色家电（例如空调变

频控制板）和需要高性能的数字电源领域。 

XMC4200 是 XMC4100 的升级版，它和 XMC4100 是 pin to pin 兼容的，但是 RAM 和 Flash

比 XMC4100 都要大一倍。 

XMC4400 系列与 XMC4200 和 XMC4100 相比，增加了 Delta-Sigma Demodulator (DSD)和

Ethernet 模块，它的主频达到了 120MHz，因此可应用于高性能的通用变频器。 

XMC4500 系列是 XMC4400 的升级版，它和 XMC4400 也是 pin to pin 兼容的，但是 RAM 和

Flash 比 XMC4400 都要大一倍，另外 XMC4500 增加了 SDMMC 模块。 

XMC4700 是 XMC4500 的升级版，频率达到 144MHz，Ethernet 的通道上升到 2 个。 

XMC4800 和 XMC4700 是 pin to pin 兼容，它集成了 EtherCAT 模块，可用于工业机器人的控

制以及步进或伺服电机控制。 

XMC4300 是 XMC4800 的简化版，去掉了 XMC4800 中大部分电机控制相关的外设，可用户

EtherCAT 的扩展 IO 模块或者通讯模块。 

 

3.2  XMC1000 系列 

3.2.1 产品特性 

 业界领先的 65nm 嵌入式闪存技术 

 32-bit ARM CortexTM-M0, 32/48MHz 

 64MHz MATH 协处理器 (CORDIC / DIVIDE) 

 Flash:8～200K 字节, RAM: 16K 字节 

 工作电压范围: 1.8V – 5.5V 

 用于 IP 加密的 AES 128 位加密下载模式 

 LED 亮度＆色彩控制单元 

 丰富的电机专用单元(CCU4,CCU8,POSIF,CMP)  

 兼容 IEC 60730 Class B 

 电容式触控 & LED 显示 
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3.2.2 产品阵营 

 

 

 

注：上面所写外设部分的通道数是最大值，其中各系列中又有很多 Part Number，每个 Part 

Number 的外设通道数和存储器容量都不一样，具体请看芯片的数据手册。 

 

3.2.3 产品应用领域 

 电机控制（支持简单控制至无传感器 FOC) 

 电动自行车，风机，电动工具 

 LED 照明 

 HD LED, RGB LED 调光 

 DALI 和 DMX 协议 

 数字电源转换 

  PFC, LLC, 逆变器 

 传感器控制 

 HMI (电容式触控 & LED 显示) 

 通用应用 
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3.3 XMC4000 系列 

3.3.1 产品特性 

 ARM Cortex™-M4 ，内置 FPU（浮点运算单元） 

 主频：80 -144MHZ 

 最快 Flash 访问,64KB-2.5MB,带 Cache, ECC 

 RAM : 20KB-512KB 

 硬件 MPU,CRC 

 多通道 DMA 

 连接内部外设信号的 ERU (事件处理单元) 

 最强的 PWM 单元（CCU4，CCU8） 

 多核多通道 12-Bit ADC 

 2 通道 12-Bit DAC 

 位置接口单元（正交编码/Hall/多通道） 

 丰富的通讯接口（USB,CAN,UART, SPI, I2C, I2S, Ethernet, EtherCAT） 

 丰富的人机接口（Capacitive Touch, LED Matrix, Programmable Ports） 

 高分辨率 PWM 单元（150ps） 

 Delta/Sigma 解调器 

 业界唯一工作温度范围达 125°C 的 Cortex™-M4 产品 
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3.3.2  产品阵营 

 

 

注：上面所写外设部分的通道数是最大值，其中各系列中又有很多 Part Number，每个 Part 

Number 的外设通道数或者存储器容量都不一样，具体请看芯片的数据手册。 

 

 

3.3.3  产品应用领域 

 白色家电 

 空调和冰箱的变频控制器 

 数字电源 

 PFC, LLC, 逆变器 

 通用变频器 

 通信模块 

 工厂自动化 

 工业机器人 
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3.4 基于 XMC 的方案优势 

3.4.1 电机控制方案 

目前主流的电机控制方案有 FOC, BLDC 和 V/f 控制方案，下面表中列出了这些方案各自的特

点和应用领域。 

 

 

下图基于 XMC1000 的 sensorless FOC 方案的模块图，XMC1000 内部的 MATH 协处理器可

以硬件实现坐标角度变换和 Park 变换。另外，此方案的 PLL 估算器仅需要一个电感参数。 
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下图是基于 XMC1000 的 3-Hall BLDC 方案模块图，CCU8 可以输出带死区的 3 对互补 PWM

波，PWM可以触发 ADC，用来同步采样绕组电流。POSIF 则用来检测 3 相 Hall 信号。 

 

 

 

下图是基于 XMC1000 的 V/f 方案模块图，CCU8 可以输出带死区的 3 对互补 PWM波。 
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基于 XMC1000 的电机控制方案优势： 

 

FOC 方案： 

优势 具体细节 

代码量少和运行时间短 代码量 < 16KB,  FOC 算法执行时间 < 20us 

减少 BOM 成本 
ADC 内部集成 Gain, 可以省掉外部运放，因此可以节省成本 0.49-

0.9€ 

对参数依赖性减少 仅需 1 个电感参数去测量 sensorless FOC 的转子角度和速度 

直接无感 FOC 启动 需要的启动功率较小 

 

BLDC 方案： 

优势 具体细节 

代码量少和运行时间短 代码量 < 12KB, 算法执行时间 < 15us 

减少 BOM 成本 ADC 内部集成 Gain, 可以省掉外部运放，因此可以节省成本 0.49-

0.9€ 

系统更加强壮 POSIF 内部带 Hall 信号的滤波器，无需外面的 RC 滤波电路 

 

V/f 方案： 

优势 具体细节 

代码量少和运行时间短 代码量 < 8KB, 算法执行时间 < 10us 

减少 BOM 成本 ADC 内部集成 Gain, 可以省掉外部运放，因此可以节省成本 0.49-

0.9€ 
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基于 XMC4000 的电机控制方案优势： 

FOC 方案： 

优势 具体细节 

集成 EtherCAT 的 XMC4800 和
XMC4300 

无需外部 EtherCAT ASIC，外部存储器，从而减少成本 

内部集成 Delta-Sigma 解调器 无需外部 Delta-Sigma 解调器 

对参数依赖性减少 仅需 1 个电感参数去测量 sensorless FOC 的转子角度和速度 

直接无感 FOC 启动 需要的启动功率较小 

超宽工作温度范围 支持高达 125°C 的工作温度 

 

BLDC 方案： 

优势 具体细节 

POSIF 减少 CPU 负担 可以检测 Hall 信号，增量式编码器信号，减少 CPU 负担 

高速 ADC 多达 4 个 ADC 内核可以同时采样，快速的 ADC 采样速度能使过零

点电流能精确采样，从而使 PWM 的占空比能在准确时间更新，减

少的能量损耗。 

 

V/f 控制方案： 

优势 具体细节 

集成 EtherCAT 的 XMC4800 和
XMC4300 

无需外部 EtherCAT ASIC，外部存储器，从而减少成本和 PCB 尺

寸 

内部集成 Delta-Sigma 解调器 无需外部 Delta-Sigma 解调器，减少 BOM 成本 
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3.4.2 LED 控制方案 

XMC1000 内部集成的 BCCU（Brightness Colour Control Unit）模块可以实现硬件指数调

光，内部的 Linear walker 机制能实现对色彩的顺滑调节。BCCU 单元有 9 个通道，每个通道

可以控制 1 个 LED 或者 3 色 LED 的一种色彩，因此 BCCU 单元可以控制 3 个 RGB LED. 

 

 

 

XMC1000 系列内部集成模拟比较器，可以实现快速的电流环控制。另外 BCCU 的输出结合

CCU8，可以实现 PDM（Pulse Density Modulation）控制，使 LED 亮度调节变得很平滑和细

腻。 
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英飞凌还提供 APP 和软件包支持 LED 照明应用中常用的通讯协议：DALI 和 DMX512. 

 

 

在 LED 应用中往往也需要对输入的 AC 进行功率因素矫正(PFC), XMC1000 系列 MCU 除了控

制 LED 以外，其它外设还可以实现 PFC 功能，如下图所示。 
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基于 XMC1000 的 LED 控制方案优势： 

优势 具体细节 

超低 CPU 负载 使用 BCCU 进行 LED 调光，模拟比较器进行电流比较 

超高系统整合度 单一芯片实现：PFC，通讯，调光 

通讯 支持 DALI, DMX512 
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3.4.3 EtherCAT 控制方案 

Ethernet for Control Automation (EtherCAT) 是一种基于以太网的高性能的工业控制总线。它

的通讯速度可以达到 100Mbps, 在一个网络配置中最多支持 65535 个从站节点。它支持多种

拓扑结构例如星型，线型，树形等。 

英飞凌最新推出的 XMC4800 和 XMX4300 系列集成了 EtherCAT 模块。 

XMC4800 资源模块图： 

 

XMC4300 资源模块图： 
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基于 XMC4800 的 EtherCAT 总线方案优势： 

优势 具体细节 

节省 BOM 成本 无需外部 EtherCAT 专用 IC, 无需外部 Flash 和 EEPROM, 无需外

部晶振 

减少 PCB 空间 单芯片解决方案能使终端产品体积更小 

封装 LQFP 封装方便布线和 PCB 错误分析 

集成电机控制单元 XMC4800 内置 2 单元 CCU8，可以做 2 轴电机控制 

兼容性 100%兼容典型 EtherCAT 专用 IC ET1100 

 

XMC4800 内部集成了电机控制模块和模拟信号检测模块，可以用于电机控制领域。

XMC4300 刨去了 XMC4800 中电机应用模块，可用于工业控制中的 I/O 模块。 

以下是基于 XMC4800 的 EtherCAT 控制方案和其它方案比较。 

左上是基于 XMC4800 的 EtherCAT 控制方案，可以看到这个方案仅需 2 片外部 PHY，无需

外部 EEPROM 和外部存储器。右上是基于其它带 EtherCAT 模块的 MCU，大部分这类的

MCU 都需要外部的 Flash 和 EEPROM，而且 PHY 需要外部的晶振。左下是基于 ASIC（例

如 ET1100）的解决方案，这种方案需要用额外的 MCU 去做控制，而且同样需要外置的

EEPROM 和外部晶振。右下是基于 FPGA 的解决方案，这种方案往往采样高性能的 FPGA 实

现 EtherCAT IP，除此之外，有些 FPGA 还可以做主控，这种方案虽然运算性能和扩展性都

较好，但是成本很高，而且同样需要外部的存储器和外部晶振。 
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4 集成开发环境 (IDE) 

4.1 DAVE4 

DAVE4 是英飞凌公司开发的基于 Eclipse 的免费开发环境。除了一般的代码编辑和调

试功能外，它内部还集成了很多 APP，这些 APP 都是基于控件的形式提供给用户的，

用户仅需在自己的应用添加需要的 APP 控件，再双击控件就可以在该控件的 GUI 中设

置相关参数，然后自动生成代码，接着就可以使用该 APP 的功能了。目前发布了

DAVE 版本中基本涵盖了常用外设的 APP。 

另外，DAVE4 中包含了 XMC Lib (Low Level Driver)，这个基层驱动库是经过完全测

试且兼容 CMSIS/MISRA 2004 标准，支持所有 XMC 产品。在 DAVE4 中新建的工程

都包含了 XMC Lib。 

在 DAVE4 下开发的工程也可方便的移到到第三方的开发环境（例如 Keil，IAR），下

面章节用详细介绍移植流程。 

 

 

4.4.1 安装 

 

DAVE4 下载地址： 
 
http://www.infineon.com/dave 

 

 

 

 

http://www.infineon.com/dave
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DAVE4 安装准备： 

 
对于以前未安装 DAVE4 版本的用户，可直接进行安装。对于之前安装过 DAVE4 的用

户需要删除库所在的文件夹 (C:\Users\yourname\Infineon\D_LibraryStore_4.1)。 

如果没有删除库文件夹，直接安装，则可能会出现下面问题。导致这个问题的原因是

安装文件检测到了 D_LibraryStore_4.1 的存在，因此没有安装新的库文件。这个会导

致新建工程时有些新的 MCU 型号找不到。 

 
 

 

DAVE4 安装问题： 

 

问题一：在 DAVE4 安装完后，可以会出现下面问题： 

- 新建工程没有反应 

- 新建工程无法选择相应的器件 

- 新建工程无法选择相应的 APP 

 

解决办法： 

 

出现这些问题的原因大部分都是因为 DAVE 的库文件没有安装完全。在这种情况下可

以安装更新库，具体步骤如下： 
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1) 选择 Help -> Install DAVE APP/Example/Device Library 

 

 
 
2) 在弹出窗口中，下拉 Work with，这里提供了在线安装和离线安装两种方法。如果

是要离线安装，则需要首先下载离线安装包： 

http://www.infineon.com/dave 
 

 
 

下载完后，将其解压到本地磁盘。注意：路径中不能有中文或者空格。 

 
 

3) 如果选择在线安装，则选择 DAVE APPs Library Manager 

 

 

http://www.infineon.com/dave
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4) 如果选择离线安装，点击 Add，Local 将离线安装包的解压目录添加进来 

 

 
 
5) 在线/离线安装 
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6) 全选，覆盖 

 

 
 

7) 如有提示，选择全部覆盖安装 
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问题二：在添加 APP 时，也可以出现找不到 Solver 路径的问题。 

 

 
 

 
解决办法： 

 

这个问题的原因是 APP 的路径设置有可能有误。重新设置路劲： 

1) Window->Preferences 

2) Dave ->Dave Preference，找到正确的安装路径，并设置 
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4.4.2 新建工程 

 

1) 新建 workspace 
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2) File -> DAVE Project 

 

 

3) 可以根据需要，选择创建下面 4 种工程中的一种。 

- Easy Start Project: 可以运行在英飞凌开发套件上实现简单功能的一个例程 

- Simple Main Project: 包含底层驱动库的一个空工程 (含 main.c) 

- DAVE CE Project: 与 Simple Main Project 类似，但可以添加 DAVE APP 

- Empty Project: 真正的空工程（不含任何文件），仅设置工程中的预定义路径 

 

 

4) 选择芯片型号，生成工程。 

 

4.4.3 导入工程 

在 DAVE4 中不能直接打开现有的工程，需要首先打开 DAVE workspace，然后导入

现有的工程文件。 
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1) File -> Import 

 

 

2)  选择 Infineon -> DAVE Project 
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3) 这里提供了两种方法导入工程. 

- Select Root Directory: 选择工程文件夹的路劲 

- Select Archive File: 选择工程压缩文件的路径 

选择 Select Root Directory，则直接打开工程文件夹，接着在 DAVE 中对文件进

行编辑将直接修改原工程文件。 

选择 Select Archive File，则 DAVE 首先将解压工程，然后将解压后的工程导入

当前 workspace。这个方法支持一次导入多个工程。（即可以将多个工程压缩打

包成一个文件，然后用这个方法导入工程） 

 

 
 

 

4.4.4 调试技巧 

 

编译和开始调试： 

 

 

 

 

 

 

编译 

（仅修改部分文件） 

编译全部 开始调试 
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编译完后，点击 ，开始调试。当第一次调试时，会弹出下面对话框。接着双击 GDB 

SEGGER J-Link Debugging，新建了一个调试配置，接着再双击新建的配置就可以开

始调试了。 

 

 
 

 

调试工具条： 

 

 

 

 
 

 

 

 

 

 

查看变量： 

 

有几种方法可以查看变量。 

 

 

 

 

 

Step return 

(F7) 

Reset 
切换到反汇编模式 

Step over 

(F6) 

Stop 

双击 

Run 

Step in 

(F5) 
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1) 可以把光标直接放在变量名上 

 

 
 

2) 双击选中变量名，右击，选择 “Add Watch Expression” 

 

 
 

3) 如果是局部变量，则直接可以在右边窗口中”Variables”栏中查看 

 

 

查看外设寄存器： 

 

先选择右边窗口中 Peripheral 栏，勾选需要查看的外设 
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打开外设寄存器查看窗口 

 

 
 

 

修改代码后重新载入： 

 

有时想在调试的时候修改代码，改完代码后可以右击左上 ”main() at…”，选

择”Terminate  and Relaunch”.  
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退出调试： 

 

点击 ，退出调试。一定要先退出调试，然后才能再次开始调试，否者将会报错。 

 

 

界面切换： 

 

编辑界面和调试界面可以相互切换。 

 

 

 
 

查看和运行反汇编程序： 

 

打开 Window->Show View->Disassembly 

 

 
 

 

点击 ，然后使用 F5，就可以开始单步调试反汇编代码了。 

 

 

 

 

 

 

 

 

调试界面 编辑界面 
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4.4.5 使用 APP 流程 

 

在帮助文档中可以找到 APP 的介绍和使用说明。以 UART APP 为例，可以打开 APP

的帮助文档来查看如何使用这个 APP，如下图所示。 

 

 

 

4.4.6 读取和修改 BMI 
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4.4.7 快捷键 

 

功能说明 快捷键 界面 

查看结构体或函数原型 F3 编辑界面 

多行注释 Ctrl + / 编辑界面 

在工程中查找 Ctrl + H 编辑界面 

Step in F5 调试界面 

Step over F6 调试界面 

 

4.4.8 文件比较功能 

 

DAVE 还支持文件比较功能，首先按住 Ctrl，选中不同工程中两个同名的文件，右击选

择 Compare With -> Each Other 
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4.4.9 文件拷贝功能 

DAVE 中支持两个工程中的文件或文件夹相互拷贝功能，如下图所示，可以选中一个

工程中的一个文件夹，然后 Ctrl+C，再选中目标工程，Ctrl+V，这样这个文件夹就可

以拷贝到目标工程中去。 

 

 

 

4.4.10 代码和变量定位 

 

1) 如何把代码放在 RAM 区域？ 

 

 如果需要把某个函数放在 RAM 中运行，可以使用__attribute__关键字， 例如： 

 

 
void __attribute__((section (".ram_code"))) CalSumInRAM(void) 

{ 

  … 

} 

 

 

ram_code 这个段是 RAM 中用于放置 RAM code 的一个段，预先在 ld 文件已经定义好

了，不需要用户自己定义。  
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 如果需要把一个文件放在 RAM 中运行，则需要修改 ld 文件，首先把这个文件从 text 

段中 exclude 出来，然后再添加到 ram_code 段中。例如把 test1.c 这个文件放在

RAM 中运行，可以如下操作： 

 
 

.text :  

{ 

…  

*(EXCLUDE_FILE( *test1.o) .text.* .gnu.linkonce.t.*); 

… 

} > FLASH 

 

.ram_code : AT(DataLoadAddr + __data_size) 

{ 

     __ram_code_start = .; 

     /* functions with __attribute__ ((section (".ram_code")))*/ 

     *(.ram_code)    

  

     /* list the object files running from PSRAM here*/ 

     *test1.o(*text.*);  

      

     . = ALIGN(4);         

     __ram_code_end = .; 

} > SRAM 

 

 

 

2) 如何把变量放在 RAM 中指定位置? 

在 ld 文件中定义一块自己的数据区，然后在源文件中就可以用__attribute__关键字把

变量放在这个区域的首地址了。 

例如把一个变量放在 0x20002000 这个地址： 

 

在 ld 文件定义一块从 0x20002000 开始的数据区： 

 
 

.myDataBlock 0x20002000: 

{ 

 *(.myDataSection) 

}> SRAM 

 

 
在源文件中把变量sum放在0x20002000的地址： 

 
 

uint8_t __attribute__ ((section (".myDataSection"))) sum; 

 

 
 

3) 如何把 const data 放在 Flash 中的指定位置？ 

在 ld 文件中定义一块自己的常量区，然后在源文件中就可以用__attribute__关键字把

变量放在这个区域的首地址了。 

例如把一些常量放在 0x10011000 开始的地址： 

 

 

 



 

 

第 58 页 

在 ld 文件定义一块从 0x10011000 开始的常量区： 

 
 

.myConstBlock 0x10011000: 

{ 

 KEEP(*(.myConstSection)) /* keep my const even if not referenced */ 

}> FLASH 

 

 

在源文件中把常量 myconst 数组放在 0x10011000 的地址。 

 
 

const uint8_t  __attribute__ ((section (".myConstSection"))) 

myconst[8] = {'a', 'b', 'c', 'd', 'e', 'f', 'g', 'h'}; 

 

 

4) 如何把代码放在 Flash 中的指定位置？ 

在 ld 文件中定义一块自己的代码段，然后在源文件中就可以用__attribute__关键字把

代码放在这个区域的首地址。 

例如把一个函数放在 0x10016000 开始的地址： 

 

在 ld 文件定义一块从 0x10016000 开始的代码区： 

 
 

.myCodeBlock 0x10016000: 

{ 

 KEEP(*(.myCodeSection)) /* keep my code even if not referenced */ 

}> FLASH 

 

 

在源文件中把 CalSum ()函数放在 0x10016000 的地址: 

 
 

void __attribute__ ((section (".myCodeSection"))) CalSum(void) 

{ 

  … 

} 

 

 
 

5) 如何把一个文件放在 Flash 中的指定位置？ 

这里有两种方法可以实现这个功能。 

 

 方法一： 把 Flash 划分成两块，把文件放在其中一块。 

例如把 test2.c 的文件放在 0x10020000 开始的地址，可以如下这么做。 
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首先把 Flash 划分成两块: 

 
 

MEMORY 

{ 

    FLASH(RX) : ORIGIN = 0x10001000, LENGTH = 0x20000 

     

    /* Add a new Flash area */ 

    FLASH_1(RX) : ORIGIN = 0x10020000, LENGTH = 0x10000    

     

    SRAM(!RX) : ORIGIN = 0x20000000, LENGTH = 0x4000 

} 

 

 

把源文件 test2.c 放在 Flash_1 区域： 

 
 

/* List files which are located in Flash_1 area */ 

.romCode :  

{ 

  *test2.o (.text .text*); 

     

} > FLASH_1 

 

 

 

 方法二：先把源文件从 text 段 exclude 出来，在最后定义一个代码段，把源文件

放置在那里。 

例如把 test2.c 的文件放在 0x10020000 开始的地址，可以如下这么做。 

 

首次把源文件从 text 中 exclude 出来： 

 
 

.text :  

{ 

…  

*(EXCLUDE_FILE( *test2.o) .text.* .gnu.linkonce.t.*); 

… 

} > FLASH 

 

 
添加到自己定义的代码段： 

 
 

.romCode 0x10020000:  

{ 

 *test2.o (.text .text*); 

    

} > FLASH 

 

 

采用这个方法需要确保 0x10020000 这个地址没有和别的代码重叠。 
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4.4.11 查看程序运行周期数 

在 DAVE 中没有寄存器可以直接查看某条语句或者某个函数的执行时间，但是我们可

以利用 ARM Cotex-M 核自带的 System Tick 来实现这个功能。System Tick 是以 CPU  

Clock 作为它的源时钟，因此 1 个 System Tick 的 count 就表示一个机器周期。 

例如需要计算 CMSIS-DSP 中 arm_sin_f32()的执行时间，则可以用下面程序。简单的

说就是在这个 API 的前把 System tick 清 0，在 API 执行完后读取 System tick 计数

值，读取的计数值就是这个 API 的执行周期数。 

   
uint32_t DURATION_TIME; 

float result1; 

 

SysTick->CTRL = 0; /* Disable SysTick */ 

  SysTick->LOAD = 0xffffff; /* Count down from maximum value */ 

  SysTick->CTRL = 0x5; /* Enable SysTick and use processor clock */ 

  SysTick->VAL = 0; /* Clear current value to 0 */ 

 

  result1 = arm_sin_f32(0.5f); 

 

  DURATION_TIME = SysTick->VAL; /* Get duration time */ 

  SysTick->CTRL = 0; /* Disable SysTick */ 

 

 

4.4.12 DAVE 工程转 Keil 工程流程 

 

DAVE4 APP 工程转 Keil MDK 步骤 

 

1) 打开或新建一个 DAVE 工程 

2) 点击 Window|Preferences 
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3) 选择 DAVE CE Preference, 勾选下面选项 

 

 
 

4) 点击 ，重新生成代码 

5) 重新生成代码后，在工程目录中会新增加一个 gpdsc 文件 
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注意： 

- 只有 DAVE APP (DAVE CE)工程可以通过这个方式转成 Keil 

- gpdsc 仅仅描述生成的代码文件的结构，即 Generated 文件夹下的这些文件 

 

在重新生成代码的过程中，生成了 RTE 文件夹，如果需要继续在 DAVE 中编

译，则需要把这个文件夹 exclude。 

 

 
 

 

 

DAVE4 LLD 工程 转 Keil MDK 步骤 

 

1) 新建一个 Keil 工程 
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2) 选择对应芯片 

 

 
 

3) 选择 CMSIS 组件 
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4) 添加用户应用文件 

 

5) 设置需要的预定义路径 

 

 

6) 选择 debugger 后，就可以在 Keil 环境下调试了 
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4.2 Keil MDK 

4.2.1 下载 

 

可以从下面地址下载最新版的 Keil MDK 版本： 

https://www.keil.com 

 

4.2.2 新建工程 

 

1) 新建一个 Keil 工程 

 

 

https://www.keil.com/
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2) 选择对应芯片 

 

 
 

3) 选择 CMSIS 组件 
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4) 添加用户应用文件 

 

5) 设置需要的预定义路径 

 

 

6) 选择 debugger 后，就可以在 Keil 环境下调试了 
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4.2.3 打开自带例程 

 

1) 打开 Keil 

2) 点击    ，打开 Pack Installer 

3) 选择 Infineon 

4) 安装 XMC1000_DFP, XMC4000_DFP, Keil Compiler 等（如已安装，则跳过） 

 

 

 

5) 选择芯片型号，例如 XMC1402-F064x0200 

6) 点 Example 
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7) 选择其中一个 Example 

 

 

8) 点击 Copy 

9) 编译 

10) 下载和运行 
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5 调试工具 

5.1 英飞凌板载 J-Link 

5.1.1 XMC1000 板载 J-Link  

XMC1000 系列的开发套件在板上集成了 J-Link。这个 J-Link 的功能完全兼容标准的

SEGGER J-Link，而且还能模拟出一个虚拟串口。它的引脚配置如下： 

Pin Signal Name XMC1300 Signal Description 

1 SWCLK P0.15 SWD clock signal 

2 SWD (SPD) P0.14 SWD/SPD signal 

3 VDDP VDDP +5V 

4 GND VSSP Ground 

5 GND VSSP Ground 

6 VDDP VDDP +5V 

7 PC_TXD P1.3 UART data received 

8 PC_RXD P1.2 UART data transmit 
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5.1.2 XMC4000 板载 J-Link 

XMC4000 系列的开发套件在板上集成了 J-Link。这个 J-Link 的功能完全兼容标准的

SEGGER J-Link，而且还能模拟出一个虚拟串口。相比 XMC1000 的板载 J-Link，它

增加了 SWV 和 Reset 引脚。它的引脚配置如下： 

Pin Signal Name XMC4500 Signal Description 

1 SWD TMS SWD signal  

2 VCC VDDP Power signal 

3 SWCLK TCK SWD clock signal 

4 Reset PORST# Reset signal 

5 SWV - SWV trace data output 

6 GND VSS Ground 

7 PC_RXD P0.1 UART data transmit 

8 PC_TXD P0.0 UART data receive 
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5.2 Segger J-link  

SEGGER 标准的 20pin JTAG 接口如下： 

Pin Signal Name Description 

1 VTref Target reference voltage 

2 NC No connection 

3 nTRST JTAG Reset 

5 TDI JTAG data input of target CPU 

7 TMS JTAG mode set input of target CPU 

9 TCK JTAG clock signal to target CPU 

11 NC No connection 

13 TDO JTAG data output from target CPU 

15 RESET Target CPU reset signal 

17 NC No connection 

19 5V-Supply 
This pin can be used to supply power to 
the target hardware  

 4,6,8,10,12,14,16,18,20 GND Ground 

 

 可以查看下面文档： 

https://www.segger.com/admin/uploads/productDocs/UM08001_JLink.pdf 

5.3 XMC-Link 

XMC-Link 是英飞凌公司开发的 J-Link 仿真器。除了兼容标准的 SEGGER J-Link 功能

之外，它还能模拟出一个虚拟串口，另外还带隔离的功能。 

它的 10-pin 接口引脚分配如下： 

Pin Function XMC1000 Connection XMC4000 Connection 

1 VCC Power supply 2.5V-5.5V(VDD) Power supply VDDP 3.3V (VDDP) 

2 SWIO/TMS Serial Wire Data (P0.14 | P1.3) Serial Wire Data, JTAG-TMS 

3 GND Ground (VSS) Ground (VSS) 

4 SWCLK/TCK Serial Wire Clock (P0.15 | P1.2) Serial Wire Clock, JTAG-TCK(TCK) 

5 GND Ground (VSS) Ground (VSS) 

6 SWO/TDO NC Serial Wire Output, JTAG-TDO (P2.1) (optional) 

7 KEY NC NC 

8 TDI NC JTAG-TDI (P0.7)(optional) 

9 GNDDetect NC NC 

10 RESET# NC PORST# (mandatory) 

https://www.segger.com/admin/uploads/productDocs/UM08001_JLink.pdf


     

第 73 页  

 

它的 8-pin 接口引脚分配如下： 

Pin Function XMC1000 Connection (Pin name) 

1 SWCLK Serial Wire Clock (P0.15 | P1.2) 

2 SWD Serial Wire Data (P0.14 | P1.3) 

3 + Power supply 2.5 V – 5.5 V (VDD) 

4 GND Ground (VSS) 

5 GND Ground (VSS) 

6 + Power supply 2.5 V – 5.5 V (VDD) 

7 TX (PC-TX) Transmissstion line of PC/laptop, receive line of XMC™ device (optional) 

8 RX (PC-RX) Receive line of PC/laptop, transmission line of of XMC™ device (optional) 

 

 

 

 

5.4 J-Link 命令行 

J-Link 命令行能实现一些实用的功能，例如擦除 Flash 和修改 BMI。 

可以在开始菜单，打开最新的 SEGGER J-Link Commander 
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打开会显示以下界面，如果可以读到 ID，则说明 J-Link 连接正常。 

 

 

5.4.1 擦除 Flash 

输入下面命令可以整片擦除 Flash。 

exec device device_name  

erase 

例如擦除 XMC4500-F144x1024，则输入： 

exec device xmc4500-f144x1024 

erase 
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5.4.2 修改 BMI 

J-Link Commander 还可以查看和修改 BMI。 

输入”GetBMI”，可以查看当前 BMI 的模式。 

 

 

上面显示 BMI 模式是 2，输入”SetBMI ?”, 可以查看 2 的含义。 

 

 输入“SetBMI 0”，可以切换到 ASC Bootstrap Load Mode. 

  

注意：切换到 ASC_BSL 模式后就不能再连接 J-Link 了，需要在 DAVE 中把 BMI 模式

改成 User Mode (SWD)后才能继续用 J-Link 调试。 
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6 编程工具（烧写工具） 

6.1 MemTool 

MemTool 是能通过串口烧写 XMC MCU 片内 Flash 的工具。MemTool 的下载地址可

以查看第一章。 

6.1.1 Boot 模式 

在了解 MemTool 用法之前，首先要先了解 MCU 的 Boot 模式。 

XMC1000 Boot 模式： 

XMC1000 系列有很多种 Boot 模式，包括 ASC_BSL (Full duplex), User Mode (SWD), 

User Mode (SPD), ASC_BSL (Half duplex)和 SSC_BSL。这些模式所用的硬件引脚如

下： 

 

 

芯片出厂时的默认 Boot 模式是 ASC_BSL (Full duplex). 在这个模式下可以使用

MemTool 通过串口线对 MCU 进行烧写。 

如果当前 MCU 的 Boot 模式是 user mode, 可以用 DAVE 把 BMI 模式设为 ASC_BSL

模式（查看 4.4.6），然后再用 MemTool 烧写。 

XMC4000 Boot 模式： 

XMC4000 的 Boot mode 是由两个外部引脚 TCK 和 TMS 决定的。如果 TCK 和 TMS

这两个引脚悬空，则芯片上电后处在 Normal mode（即 TCK 和 TMS 引脚在芯片内部

是弱下拉和弱上拉的）。而 UART 烧写所需模式是 ASC_BSL 模式，因此在 烧写之前

需要把 TMS 下拉，把 Boot 模式配置成 ASC_BSL 模式。 
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UART 烧写引脚是 P1.4 (U0C0_DX0B)和 P1.5 (U0C0_DOUT0)。这两个引脚是固定

的。 

6.1.2 烧写流程 

首先确保 MCU 是处在 ASC_BSL 模式，串口连接正确（查看 6.1.1）。 

1) 打开 MemTool 

 

 

2) 如果第一次使用 MemTool，需要配置芯片信息步骤如下： 

- 选择 Target -> Change 

- 在弹出窗口选择 New 
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3) 选择”Use a default target configuration”, 选择目标芯片(以 XMC4500 为例),点
Finish 

 

 

4) 在接下去弹出的窗口中，点击 Save 

5) Save 之后，配置界面如下，点击 OK 
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6) 下面列出了 XMC4500 各个 sector 的地址和容量 

 

 

7) 点”Target->Setup…”, 选择 COM 口 
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8) 点击 connect 

 

 

9) 此时显示已经连接，接着点击 Open File，选择需要烧写的 Hex 文件 

 

 



     

第 81 页  

 

10) 点击 Select All 

 

 

11) 点击 Add Sel, 右边地址会将左边内容添加至 Buffer 区 

12) 点击 Program 

 

 

13) 当提示 Success，表示烧写完毕 
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14) 点击 Exit，退出，烧写过程结束 

 

 

注意：默认情况下，Program 包括了烧写前对 Flash 的擦除和烧写后对烧写内容的校

验。 
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6.1.3 查看校验和 

MemTool 能够计算 hex 文件中数据的校验和。 

1) 连接 

2) Open File， 

3) 点击 Device -> Calculate Device Checksum 

 

 

4) 计算完成后，能显示 
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6.1.4 读取 Flash 内容 

MemTool 也可以读取目标芯片 Flash 中的内容。 

1) 连接目标芯片 

2) 点击 Read 

 

 

3) 点击 New 
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4) 根据 Flash 大小，填写数据首地址和尾地址后，点击 OK. 

 

 

5) 此时会显示读取 Flash 的区域，点击 Start 

 

6) 开始读取文件 
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7) 文件读取完成后，点击 Exit，退出。这时候在下面窗口左侧显示读取 Flash 的地址

和 Flash 中数据的校验和。 

 

 

8) 点击 Save As，可以把读取的数据存成一个文件。这些数据可以继续去烧写别的

MCU。 
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6.1.5 Flash 加密和解密 

对于 XMC4000 系列的 MCU，可以通过 MemTool 对 Flash 进行加密和解密。 

加密： 

1) 连接芯片 

2) 设置密码 

a) 点击 Setup 

b) 选择 Protection/BMI 

c) 输入密码 

d) 点击 Check 

 

3) 点击 HW Project 
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4) 勾选”Enable Global Read/Write Projection”, 点击 Start 

 

 

 

5) 在弹出来的对话框中，点击 Yes，开始加密，加密完成后弹出下面窗口，点击 OK 

 

6) 复位 MCU, 或者先断电再上电 

7) 重新连接 MCU, 发现各个 sector 已经加上了锁，表示已经加密 
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暂时解密： 

1) 连接芯片 

2) 输入密码 

a) 点击 Setup 

b) 选择 Protection/BMI 

c) 输入密码 

d) 点击 Check 

e) 选择”Try to disable protection when FLASH handling is activated” 

f) 点击 OK 

 

 

3) 这个时候可以看到 Flash 的锁已经打开，表示 Flash 可以操作了。 

 

4) 接着就可以继续操作 Flash 了。 
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永久解密： 

1) 连接芯片 

2) 设置密码 

a) 点击 Setup 

b) 选择 Protection/BMI 

c) 输入密码 

d) 点击 Check 

e) 点击 OK 

 

3) 设置密码 

a) 点击 HW Protect 

b) 选择 Remove all Protection 

c) 点击 Start 
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4) 在弹出窗口，点击 Yes 

5) 显示解除芯片保护成功 

 

 

6) 复位芯片或者先断电再上电 

7) 连接芯片，发现 Flash 的锁已经消失，表示 Flash 已经解除保护 

 

 

6.2 XMC Flasher 

XMC Flasher 是能通过 SWD 口烧写 XMC MCU 片内 Flash 的工具。XMC Flasher 下

载地址如下： 

www.infineon.com/xmcflasher 

 

在使用 XMC Flasher 之前，首先需要安装下面两个软件： 

1) Oracle JAVA™ JRE 1.8.0_72 or higher 

http://www.oracle.com/technetwork/java/javase/downloads/index.html 

2) Segger JLINK software 5.12 or higher 

https://www.segger.com/jlink-software.html 

 

 

 

http://www.infineon.com/xmcflasher
http://www.oracle.com/technetwork/java/javase/downloads/index.html
https://www.segger.com/jlink-software.html
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6.2.1 烧写流程 

1) 双击 XMCFlasher.jar, 打开 XMC Flasher 

2) 选择设备 

 

3) 连接芯片，连接成功后会显示设备名字和设备唯一 ID 

 

 

4) 选择 Hex 文件, 选择后会在下面显示该 Hex 文件名字 

 

5) 点击 Progam，启动烧写。 
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6.2.2 擦除芯片 

这里的擦除芯片指的是整片 Flash 的擦除(chip erase)。 

1) 连接芯片 

2) 点击 Erase 

 

6.2.3 修改 BMI 

XMC Flasher 还具有修改 BMI 的功能。XMC1000 系列的产品出厂时的 BMI 模式是

ASC_BSL 模式，在这个模式下，不能调试芯片，需要把 MCU 的模式修改为 SWD 或

者 SPD 后，才能进行调试。 

1) 首次连接芯片 

2) 如果芯片的 BMI 模式是 ASC_BSL 模式，则会报错。 
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3) 点击 OK, 点击 BMI->BMI Get Set… 

 

 

4) 点击 Get BMI 可以获取芯片目前的 BMI 模式 

 

 

5) 点击 Set BMI 可以设置 BMI 模式，例如把模式设为 USER_MODE (SWD0) 
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7 uC/Probe 

7.1 uC/Probe 简介 

英飞凌最近发布了一款新的调试工具 – uC/Probe，可以实时的观察变量或者外设寄存

器的变化。它以各种控件的形式表示实际的量值，例如文本框，仪表盘，甚至示波

器。这种形式的调试会对一些需要动态观测参数的应用带来很大的方便，例如电机和

数字电源应用。但是使用它之前，需要首先 download 程序到 MCU，然后 load elf 文

件到 uC/Probe。具体请看附件使用说明。 

uC/Probe 这个工具是 Micrium 开发的，一般来说，开发者需要使用需向 Micrium 购买

License. 我们提供的版本是 Micrium 给 Infineon 定制的，即只能调试 XMC MCU，并

且是免费提供给 XMC 用户使用的。 

 

7.2 uC/Probe 使用说明 

1) 打开 uC/Probe 
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2) 鼠标点击左上角‘File’，可以看到两个 pdf 手册描述细节，再点一下 File 返回 

 

 

3) 点击 CDF，在列表里选择对应 MCU 型号 
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4) 以 Keil 例程为例 

a) 生成一个 KEIL 的 XMC1300 的 Blinky 工程，做测试用途 

 

b) 解压缩安装文件里附带的 Micrium-Probe-TargetCode.Zip,找到下面路径 

- Micrium-Probe-TargetCode\Micrium\Software\uC-Probe\Target\Scope 

c) Copy scope 下三个文件到测试工程目录，添加 C 文件到 Keil workspace 

 

d) 打开 option, 添加路径 

- .\ 

e) Include 两个头文件 

 

 

5) 配置 cfg 文件 

a)   打开 cfg 头文件，配置示波器通道，根据自己芯片的内存大小选择通道数和采

样数，这里把默认的 8 通道改成 2 通道。 
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6) 添加程序 

A.   在 Main.c 里面调用初始化函数 ProbeScope_Init(10000).这里的形参 10000

代表下面的采样程序每 0.1mS（10000HZ）就会去采样需要观察的变量。 

B.   修改 SysTick_Config()参数，每 0.1ms 产生一次 System Tick 的中断 

C.   在 System Tick 中断服务函数中添加 ProbeScope_Sampling()函数 

D.   变量 Count 和 Count1 用来测试 

 

 

 

7) 载入对应的编译器仿真文件 

a) 编译完成后，download 到 XMC1300BOOTKIT，切换回 uC_Probe 

b) Keil 用户选择 axf 文件打开（DAVE 用户选择 elf，其他找对应的文件后缀） 
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8) Symbol Browser 窗口 

a) 在 Symbol Browser 窗口可以看到相应的变量和外设 

b) 查找窗口输入名字可以快速找到寻找的内容 

c) 圆圈处可以关闭和展开分支 

 

 

仪表盘功能 

1) 增加一个仪表显示 

a) 选择 Angular Gauges，选择一个仪表，拖到 datascreen 里面 
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2)  关联变量和仪表 

a) 在变量里选择一个拖入仪表界面 

 

 

 

3) 设定显示比例 

a)   确认 Bootkit 里面程序已经运行 

b)   由于 count 设为 uint16_t,从 0-65535 循环，因此把比例 Scaling Factor 设为

0.001，这样指针转到 65 到 66 之间就回到 0 

c)   设定完成后，点击 Run，可以看到指针动态从 0 到 65 移动 
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 数字表功能： 

1) 增加一个数字表显示 

a) 选择 Numeric Indicators,鼠标拖一个数字表到 DataScreen 

 

 

2) 关联变量到数字表 

a) 拖变量 Count1 到数字表 

 

3) 显示结果 

a) 点击 Run 后，可以看到变量 Count1 显示到数字表，不断变化 
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示波器功能 ： 

1) 增加示波器功能 

a) 右键点击 project，选择 Add Oscilloscope 

 

 

2) 把变量添加到示波器 

a) 用鼠标把变量 count，count1 分别拖到 Scope Setting 
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3) 幅度和时间轴调节 

a) 点击 Auto_Scale 把幅度调整到合适范围 

b) 时间轴在 Sampling Clock divide 调整 

c) 触发和停止等见操作界面，和正常示波器类似 

d) 双击 scope Setting 可以放大示波器到全屏 

e) 拖拽上方圆圈处可以进行局部放大 

 

 
 

4) 拖拽寄存器 PORT0.IN 到示波器设置 
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5) 下拉菜单选择 PORT0.IN 

 

 

 

6) 选择 Bit，第 6 位 

 

 

 

7) 输出结果 
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7.3 uC/Probe 文件资源 

安装程序包： 

 

 

 

示波器辅助功能代码位置： 
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8 开发套件 

英飞凌提供 3 类开发套件：入门套件，应用套件和演示套件。可以浏览下面网站，查看套件具

体情况。 

www.infineon.com/xmc-dev 

 

套件类型 型号 特性 图片 

XMC1000 

入门套件 

KIT_XMC_2GO_XMC1100_V
1 

- XMC1100-Q024 

- 板载J-Link 

- 所有引脚均引出来 

 

KIT_XMC11_BOOT_001 

- XMC1100-T038 

- 板载J-Link 

- 所有引脚均引出来 

- Arduino接口  

KIT_XMC12_BOOT_001 

- XMC1200-T038 

- 板载J-Link 

- 所有引脚均引出来 

- 8 x LED 

- 1 x Pentiometer 

- 扩展接口 
 

KIT_XMC13_BOOT_001 

- XMC1300-T038 

- 板载J-Link 

- 所有引脚均引出来 

- 8 x LED 
- 1 x Pentiometer 

- 扩展接口 
 

KIT_XMC14_BOOT_001 

- XMC1400-Q064 

- 板载J-Link 

- 所有引脚均引出来 

- 8 x LED 

- 1 x Pentiometer 

- 扩展接口 

- 1 x CAN 

 

XMC4000 

入门套件 
KIT_XMC45_RELAX_LITE_V1 

- XMC4500-F144 

- 板载J-Link 

- 4 x SPI-Master, 3x I2C, 3 x I2S, 
3 x UART, 2 x CAN, 17 x ADC 

- 2 x user button and 2 x user 
LED 

 

http://www.infineon.com/xmc-dev
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KIT_XMC45_RELAX_V1 

- XMC4500-F144 

- 板载J-Link 

- 4 x SPI-Master, 3x I2C, 3 x I2S, 
3 x UART, 2 x CAN, 17 x ADC 

- Ethernet PHY and RJ45 jack 

- 32 Mbit Quad-SPI Flash 
- microSD card slot 

 

KIT_XMC47_RELAX_LITE_V1 

- XMC4700-F144 

- 板载J-Link 

- 2 x user button and 2 x user 
LED 

- 3.3V Arduino接口 
 

KIT_XMC47_RELAX_V1 

- XMC4700-F144 

- 板载J-Link 

- Quad SPI Flash 
- microSD Card Slot 
- Ethernet PHY and RJ45 Jack 

- CAN node  

六角板 

应用套件 

KIT_XMC45_EE1_002 
KIT_XMC45_EE2_001 
KIT_XMC44_EE1_001 
KIT_XMC42_EE1_001 

- XMC4500/XMC4400/XMC4200 

- 板载J-Link 

- COM接口 

- ACT接口 

- HMI接口 
 

KIT_XMC4X_HMI_OLED_001 

- HMI接口 

- Micro SD Card Slot 

- Matrix OLED Display 
- 2.5 mm stereo receptacle  
- Stereo audio codec  

 

KIT_XMC4X_COM_ETH_001 

- COM接口 

- 10/100Mbps Ethernet (RJ45) 
- CAN transceiver with CAN 

connector 
- RS-485 transceiver, full-duplex, 

bootable 
- I2C based IO expander  

KIT_XMC4X_MOT_GPDLV_0
01 

- ACT接口 

- 3 phase low voltage half-bridge 
inverter 

- Gate Driver IC (6ED003L02-F2) 
- Delta-sigma modulator 

- Inductive resolver interface 
- Hall sensor interface  

KIT_XMC4X_AUT_ISO_001 

- ACT接口 

- ISOFACE OUT, up to 8 
channels 

- ISOFACE IN, up to 8 channels 
- I2C based IO expander up to 8 

channels 
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电机 

应用套件 

KIT_XMC1X_AK_MOTOR_00
1 

主控板 

- XMC1300 

- 板载J-Link 

 

电机板 

- 12 – 24V, up to 3A 
- On board 3-phase motor (24V, 

15W) with hall sensors, Optional 
encoder interface 

- Power supply 24V, 1A 

 

XMC_LVPB V1.0 

控制板： 

- XMC1300 

- POSIF电机位置接口 

- RS232通讯接口 

- SPI通讯接口支持片外DAC扩展 

- 调试接口 8针J-LINK接口 

- 20pin功率板接口 

 

功率板： 

- 功率电源接口 

- 电机输出接口 

- 辅助电源 

- 20pin主控板接口 

 

 

LED 

应用套件 

KIT_XMC1X_AK_LED_001 

控制板： 

- XMC1200 

- 板载J-Link 

 

Colour LED Card： 

- 3 RGB LEDs, 10mA 
- Connectivity: DALI, DMX, RF 
- Ambient light sensor 
 

White LED Card： 

- 20 LEDs on 4 strings, 20mA 

- Connectivity: DALI, RF 
- Ambient light sensor 
- Temperature sensor 

 

 

 

KIT_XMC1_LED_CC_EXP_00
1 

- Low cost, flicker-free, smart and 
connected single channel LED 
driver demonstrator 

- 15W Single Channel CCM 
DC/DC Buck converter in peak-
current control mode 

- Software-based automatic 
adaptation to different input DC 
voltages and LED forward 
voltages 

- Isolated DALI Interface card. 
DALI Software Stack available 

 

EtherCAT

应用套件 
KIT_XMC48_RELAX_ECAT_V
1 

- XMC4800-F144 

- 板载J-Link 

- Quad SPI Flash 
- microSD Card Slot 
- Ethernet PHY and RJ45 Jack 

- CAN node 
- EtherCAT® node 
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Arduino 

应用套件 

KIT_LED_XMC1202_AS_01 

- Compatible with Arduino Uno R3 
and XMC1200 Boot Kit  

- Easy configurable for various 
light engines and any input 
voltage (within operating 
conditions) 

- Wide DC input voltage range 
- Simple I 2C interface  

DC-
MOTORCONTR_BTN8982 

- Compatible with Arduino Uno R3 

- Capable of high frequency PWM  
- Adjustable slew rates for 

optimized EMI by changing 
external resistor 

- Driver circuit with logic level 
inputs 

- Diagnosis with current sense 
 

数字电源 

应用套件 
KIT_XMC_DP_EXP_01 

主控板： 

- XMC1300/XMC4200 

- 板载 J-Link 

 

数字电源开发板： 

- Synchronous buck converter 

- On-board switches for step load 
testing 

- PMBus communication 
- Network analyzer ready for 

stability analysis 
- Option to connect a second buck 

for interleaving control 

 

750W 

电机控制演

示套件 

KIT_XMC750WATT_MC_AK_
V1 

主控板： 

- XMC1300/XMC4400 

- 板载J-Link 

 

功率板： 

- 110-230 V / 750 W 
- Input Filter and Active PFC 
- 3-Phase Inverter by Reverse 

Conduction IGBT  

600W LLC 

演示套件 
EVAL_600W_12V_LLC_C7_d 

- Output voltage: 12V 
- Output current: 50A 

- Peak efficiency @ 50% load > 
97,4%  

- Efficiency @ 10% load > 95% 
 

 

3KW Dual 

LLC 演 示

套件 

 

EVAL_3KW_2LLC_C7_20 

- Peak efficiency >98.4% 
- Flat efficiency plot from 10% to 

100% load 
- Flexible design adjustment and 

fine tuning through the GUI 
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9 XMC 相关链接 

XMC 主页 www.infineon.com/xmc 

XMC4000 主页 www.infineon.com/xmc4000 

XMC1000 主页 www.infineon.com/xmc1000 

XMC 开发套件 www.infineon.com/xmc-dev 

XMC 生态系统 www.infineon.com/xmc/ecosystem 

MatrikonOPC UA Embedded SDK  www.infineon.com/matrikonopc 

Embedded coder library for Matlab www.infineon.com/matlab 

XMC 底层驱动库 www.infineon.com/xmclib 

XMC 方案和技术介绍视频 www.infineon.com/xmc-mediacenter 

XMC4800 产品 www.infineon.com/xmc4800 

XMC EtherCAT 产品和技术介绍 www.infineon.com/ethercat 

XMC Arduino 产品介绍 www.infineon.com/arduino 

XMC Link www.infineon.com/xmclink 

XMC Flasher www.infineon.com/xmcflasher 

DAVE 主页 www.infineon.com/xmcflasher 

 

http://www.infineon.com/xmc
http://www.infineon.com/xmc4000
http://www.infineon.com/xmc1000
http://www.infineon.com/xmc-dev
http://www.infineon.com/xmc/ecosystem
http://www.infineon.com/matrikonopc
http://www.infineon.com/matlab
http://www.infineon.com/xmclib
http://www.infineon.com/xmc-mediacenter
http://www.infineon.com/xmc4800
http://www.infineon.com/ethercat
http://www.infineon.com/arduino
http://www.infineon.com/xmclink
http://www.infineon.com/xmcflasher
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